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Abstract

Retinal scarring with vision loss continues to be an enigma in individuals with advanced 

age-related macular degeneration (AMD). Müller glial cells are believed to initiate and 

perpetuate scarring in retinal degeneration as these glial cells participate in reactive gliosis and 

undergo hypertrophy. We previously showed in the murine laser-induced model of choroidal 

neovascularization that models wet-AMD that glial fibrillary acidic protein (GFAP) expression, 

an early marker of reactive gliosis, increases along with its posttranslational modification 

citrullination. This was related to increased co-expression of the citrullination enzyme peptidyl 

arginine deiminase-4 (PAD4), which also colocalizes to GFAP filaments. However, whether such 

hypercitrullination in Müller glial drives fibrotic pathology has remained understudied. Here, 

using male and female C57Bl6 mice subjected to laser injury, we investigated in a temporal study 

how citrullination impacts GFAP and PAD4 dynamics. We found that high molecular weight 

citrullinated species that accumulate in Müller glia corresponded with dynamic changes in GFAP 

and PAD4 showing their temporal redistribution from polymeric cytoskeletal to soluble protein 

fractions using immunostaining and western blot analysis. In conditional glial-specific PAD4 

knockout (PAD4cKO) mice subjected to laser injury, there was a stark reduction of citrullination 

and of polymerized GFAP filaments. These injured PAD4cKO retinas showed improved lesion 
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healing, as well as reduced fibronectin deposition in the subretinal space at 30 days. Taken 

together, these findings reveal that pathologically overexpressed PAD4 in reactive Müller glia 

governs GFAP filament dynamics and alters their stability, suggesting chronic PAD4-driven 

hypercitrullination may be a target for retinal fibrosis.
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1 | INTRODUCTION

Age-related macular degeneration (AMD) is the leading cause of vision loss for the aging 

population in developed nations (Ambati et al., 2003). This retinal disease is characterized 

by degeneration of the macula, the densely populated area of cone photoreceptors that 

provides central vision and acuity. AMD has two distinct forms—dry and wet—both 

affecting the photoreceptors in the macula. Dry-AMD evokes gradual vision loss, and 

accumulation of lipid deposits called drusen below the retinal pigment epithelium (RPE). 

In contrast, wet-AMD occurs when choroid blood vessels penetrate the Bruch’s membrane, 

damaging the RPE and photoreceptors, resulting in vascular leakage. Whereas dry-AMD 

is more prominent, wet-AMD progresses faster and causes acute loss of vision due to 

choroidal neovascularization (CNV). Despite available treatments that target CNV, many 

wet-AMD patients develop scarring and permanent vision loss. One key player in the 

perpetuation of scarring in AMD may be glial cells, as they contribute to scarring via 

chronic gliosis (Telegina et al., 2018).

Retinal gliosis is a reactive process driven mainly by Müller cells, the predominant glial 

cell type in the retina (Bringmann et al., 2009). Müller cells are responsible for trophic 

support of the photoreceptors and retinal neurons and they become reactive, proliferative, 

and hypertrophic upon injury or insult. While gliosis can be neuroprotective in response 

to acute injury, its sustained activation causes pathologies associated with a wide range of 

neurodegenerative retinal diseases, including AMD (Wu et al., 2003).

The hallmark of gliosis is increased expression of the intermediate filament (IF) proteins 

glial fibrillary acidic protein (GFAP) and vimentin in Müller cells (Bringmann & 

Wiedemann, 2012). In the retina, overabundance of IF proteins can cause mechanical 

distortion, and cell death (Edwards et al., 2017; Verardo et al., 2008). Mice lacking 

both GFAP and vimentin showed reduced photoreceptor damage after retinal detachment, 

indicating that these two IF proteins play a significant role in the perpetuation of 

glial scarring (Verardo et al., 2008). Moreover, targeting the chronic overexpression of 

either IF protein in adult mice to overcome embryonic compensatory mechanisms have 

revealed that GFAP and vimentin contribute to MG hypertrophy in a retinal disease model 

(Hippert et al., 2021). Upon insult or injury, GFAP and vimentin undergo posttranslational 
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modifications (PTMs) such as phosphorylation, which play important roles in altering 

their IF structures and abundance of soluble IF precursors, and consequentially, govern 

cell behaviors (Eriksson et al., 2004; Hol & Capetanaki, 2017; van Bodegraven & Etienne-

Manneville, 2021). One notable PTM affecting IF proteins, but is relatively understudied, 

is citrullination (Briot et al., 2020). Citrullination is an irreversible modification of protein 

arginine residues by the α-amino acid citrulline, an enzymatic reaction catalyzed by peptidyl 

arginine deiminases (PADs) (Witalison et al., 2015).

Citrullinated proteins have been recognized as biomarkers in several major autoimmune 

and chronic fibrotic diseases and targeting PADs has shown benefits in several preclinical 

models (Lewis et al., 2015; Nicholas et al., 2004; Willis et al., 2017). Notably, it was shown 

that citrullination is increased in human wet-AMD eyes, but PAD2 levels were not (Bonilha 

et al., 2013), suggesting that other PADs may be responsible for disease-related citrullination 

in the retina (Hollingsworth et al., 2018). Among the five PADs, PAD2 and PAD4 are 

expressed in normal murine retinas, while PAD4 gene and protein expression was shown to 

be induced in retinas following ocular exposure to alkali (Wizeman et al., 2016; Wizeman 

& Mohan, 2017). These findings suggested that PAD4 may play a key role in citrullination 

during Müller cell gliosis.

Citrullination of GFAP filaments occurs very early after injury, and PAD4 colocalization 

on these filaments occurs concomitantly in reactive Müller glia (Wizeman et al., 2016; 

Wizeman & Mohan, 2017). PAD4 colocalization on filamentous GFAP was also observed 

in the murine laser-induced model of CNV (Palko et al., 2022). Defining PAD4’s key 

role in this PTM, conditional glial-specific PAD4 knockout (PAD4cKO) mice subjected to 

laser injury showed significantly reduced hypercitrullination (Palko et al., 2022). However, 

whether such a mechanism occurs in genetic diseases was subsequently revealed in a 

genetic model of spontaneous retinal degeneration (JR5558 mice) that revealed heightened 

citrullination (hypercitrullination), with both citrullinated GFAP and PAD4 being localized 

in reactive Müller glia. Such maladaptive chronic retinal hypercitrullination was also seen 

in severely diseased human wet-AMD maculae demonstrating that hypercitrullination is 

retained into end stages of retinal disease (Palko et al., 2022). Because Müller glial 

endfeet play such a critical role in pathological hypercitrullination, we have termed it the 

citrullination bunker (Palko et al., 2022).

In this study, we examined the PAD4-citrullination axis to study how reactive gliosis 

contributes to subretinal fibrosis (Ishikawa et al., 2016) and focused on citrullination of 

GFAP, as this IF protein serves an internal reference for the global citrullination changes 

occurring in reactive Müller glia. Through use of the PAD4cKO mice in experimental 

laser-induced retinal gliosis we demonstrate an important role for PAD4 in pathological 

hypercitrullination and suggest that PAD4 may also be an important target for subretinal 

fibrosis.
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2 | METHODS AND MATERIALS

2.1 | Mice and laser injury

C57BL/6J mice were purchased from the Jackson Laboratory (Bar Harbor, ME), and 

maintained in-house. The laser injury model of CNV (Liu et al., 2019) was used as an 

experimental means to elicit and study acute and chronic retinal gliosis (Palko et al., 

2022), adopting this model to examine subretinal fibrosis (Ishikawa et al., 2016). Equal 

numbers of male and female mice, at 3 to 5 months of age were used as done previously 

(Palko et al., 2022). In brief, mice were anesthetized using an intraperitoneal injection 

of ketamine/xylazine according to body weight and phenylephrine and tropicamide were 

applied topically to dilate pupils. GenTeal eye gel (Alcon Laboratories, Inc.) was applied 

on the cornea to facilitate contact with the microscope lens. Mice were placed on a holder 

in front of the imaging objective of the Micron III Imaging System (Phoenix, AZ). The 

objective lens was advanced to contact the mouse cornea and the retinal pigment epithelium 

(RPE) was brought into focus. The Meridian Merilas Nd-Yag 532 nm alpha green laser 

photocoagulator integrated with the Micron III camera was employed to produce the laser 

burns on the RPE. First, a low power red laser was employed to guide the position of laser 

spot on the retina prior to use of the green laser for tissue ablation. The 532 nm laser beam 

of 50 μm in diameter was employed to deliver 250 mW at 100 ms focal lesions in six to 

eight equally spaced regions in a circular pattern surrounding the optic nerve. This laser 

injury protocol was optimized to produce reproducible retinal lesions marked by chronic 

gliosis that resulted in subretinal fibrosis. Care was taken to avoid targeting tissue close 

to retinal blood vessels. Mice were recovered on heating pads and transferred to standard 

cages upon recovery. Upon euthanasia, mouse eyes were enucleated, immediately frozen on 

dry ice, and maintained at −80°C. Mice were euthanized at three time points: 7-, 16-, and 

30-days post-laser injury.

Male and female B6.Cg-Tg(GFAP-cre/ERT2)505Fmv/J (Stock No: 012849; Jackson 

Laboratory, Maine; termed GFAP-CreERT2 in short; RRID:IMSR_JAX:026708) mice were 

purchased and breeding colonies established. We also purchased B6.Cg-Padi4tm1.2Kmow/J 

(Stock No: 026708; Jackson Laboratory, Maine; termed Padi4flox/flox in short; 

RRID:IMSR_JAX:012849) male and female mice and bred this line in-house at the Center 

for Mouse Genome Modification. Colonies of both transgenic lines were maintained as 

breeders. The GFAP-CreERT2 line was crossed with Padi4flox/flox line through a breeding 

strategy (Scheme 1) to obtain the desired double-transgenic PAD4cKO mouse line. This 

procedure involved selecting the correct genotype of the mouse pups using polymerase chain 

reaction and maintaining them to adulthood for subsequent breeding experiments. Once all 

founder breeding lines were established, subsequent mouse breeding was done to obtain 

a large enough colony size of each line for use in experiments. Starting 1 day prior to 

laser injury, adult male and female PAD4cKO and transgenic Padi4flox/flox mice (termed 

control) were administered tamoxifen for 4 days by intraperitoneal (i.p.) injection to induce 

Cre expression (see Scheme 2) in reactive glial cells as previously reported (Palko et al., 

2022). Following this protocol, we found a 5.9-fold reduction of PAD4 protein levels in 

PAD4cKO compared to the control injured mice providing evidence of sufficient PAD4 
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target deficiency (Palko et al., 2022). Tamoxifen-injected mice were placed in vented cages 

and housed in a dedicated chemical isolation room until analyzed.

2.2 | Western blot analysis

Mice were euthanized and enucleated 7 and 16 days after laser injury for these experiments. 

The anterior ocular tissues were carefully separated from the posterior eye cups and the 

latter tissue (collected from a pool of 2 eyes) was employed for protein extraction. We 

performed separate extractions for each of the western blot analysis. Tissues were minced 

in ice-cold soluble buffer (20 mM Tris buffer, 200 mM NaCl, 1% NP-40, 1 mM sodium 

vanadate, and 1 mM phenylmethyl sulfonyl fluoride) supplemented with a proteinase 

inhibitor cocktail (Roche, Indianapolis, IN), as previously described (Wizeman et al., 2016). 

Samples were left on ice for 45 min and then spun at 14,000× g for 5 min at 4°C. The 

supernatant was removed, sheared through the tip of a p200 pipette, and spun again at 

14,000× g for 5 min. The supernatants representing the “soluble fractions” were collected 

and kept on ice. The protein concentration of the soluble fractions was quantified using a 

BSA standard curve and a BCA kit (Pierce BCA Assay), and typically 20 μg protein was 

loaded. The insoluble pellets were extracted with 2× ß-mercaptoethanol/Laemmli buffer, 

frozen/thawed (dry ice/warm water), and vortexed for 30 s, repeating this process three 

times. These extracts representing the cytoskeletal (insoluble) fractions were centrifuged at 

14,000× g for 5 min at room temperature to pellet debris. The supernatants were used as 

the cytoskeletal fraction, which we previously estimated to contain 12 microgram protein 

(Wizeman et al., 2016; Wizeman & Mohan, 2017). Soluble and cytoskeletal fractions were 

finally boiled at 100°C for 10 min, and soluble and cytoskeletal fractions were separately 

analyzed by western blotting.

Protein was run on Criterion TGX Stain-Free 4%–20% gels (BIO-RAD, CA). These stain-

free gels were imaged on a BioRad gel dock imager (ChemiDoc XRS+ Gel Imaging System, 

BIO-RAD, CA) and subsequently transferred onto nitrocellulose membranes as described 

(Palko et al., 2022). Chemiluminescence was used to visualize western blot bands on the 

BioRad gel dock imager, and images of stain-free blot loading were used as a loading 

control for all western blot analysis as done previously (Palko et al., 2022) following other 

published literature (Rivero-Gutierrez et al., 2014). This method of normalization offers 

a more linear range and decreased variability compared to common housekeeping genes 

(Rivero-Gutierrez et al., 2014). ImageJ (also known as FIJI) software (RRID:SCR_003070) 

was used to measure density of bands and the arbitrary units were calculated by dividing the 

density reading of the target protein band on western blots divided by the stain-free density 

reading for that respective sample lane (between 37 kDa and top of gel). Quantitation and 

statistical analysis of data was performed using GraphPad PRISM statistical software (see 

Statistical Analysis).

2.3 | Immunostaining

Mice were euthanized and eyes enucleated 7, 16, and 30 days after laser injury for these 

experiments. Mouse eyes from control and injured eyes were enucleated, immediately 

embedded in optimum cutting temperature compound (OCT; Tissue-Tek, Radnor, PA), 

and stored at −80°C. Immunostaining was performed as previously described (Palko et 
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al., 2022; Wizeman et al., 2016). Briefly, 12 μm cryo-sections were air dried for 30 

min at room temperature, fixed with 4% paraformaldehyde/PBS for 10 min, and then 

washed three times for 5 min with PBS. Samples were probed with primary antibodies 

(Table 1) diluted in DAKO background reducing solution (Agilent, S3022) at 37°C for 

3 h or overnight at 4°C. After three washes with PBS for 15 min, slides were then 

incubated with secondary antibodies (Table 1) for 1 h at room temperature (RT), and then 

washed three times for 10 min before imaging. Stained sections were routinely imaged 

using an Olympus IX81 epifluorescence microscope with 20× objective and MetaMorph 

software to ascertain staining efficiency. Some higher magnified images were captured 

employing 40× objective on a Leica THUNDER 3D imager microscope with Leica software. 

Immunofluorescence images were quantified using ImageJ software. The immunostained 

area of protein expression in lesions was quantified and compared between control and laser 

injured groups. Three different sections from each mouse were considered in quantification 

studies. This analysis method was also used for the knockout mouse studies, and area 

of staining in the lesions was quantified and compared between control laser injured and 

PAD4cKO laser injured groups.

2.4 | Quantification of lesion size and antibody staining from retinal sections

For fundus imaging, mice were anesthetized and both eyes were lasered as described 

(Section 2.1). Fundus images were obtained at 30 days post-injury using the Micron III 

fundus camera. Images of lesions were collected, and a random set from those with clear 

visualization of lesions were used for quantification (52 lesions from 7 control mice and 

76 lesions from 10 PAD4cKO mice randomized to sample both left and right eyes in each 

group). Lesion size was measured following the instructions in ImageJ software (https://

imagej.nih.gov/ij/docs/menus/analyze.html#ap). The retinal fundus image was opened from 

within the application and converted to gray scale 8-bit image. Next, individual lesions were 

selected, and each processed separately. First, the rectangle drawing tool in ImageJ was 

used to demarcate a square border around the lesion. From the Image menu the dropdown 

Duplicate menu was selected and applied that resulted in a new smaller window appearing 

containing only the selected lesion image. This lesion image was subjected to thresholding 

by selecting from Image menu → Adjust from the dropdown and then → Threshold. 

The lesion area appeared red against the gray background. To reduce background, the 

brightness and contrast was adjusted. This allowed the circular lesion represented by the 

red color to be clearly defined, which was converted to binary image after thresholding. 

From the Analyze menu the dropdown Analyze Particles was then selected. This produces 

a new window with a dialog box that was configured (Size: 0-infinity; Circularity: 0.00–

1.00; Show: Outlines). By additionally selecting Display results and Summarize in this 

menu the area of the stained region was reported. This process was repeated for individual 

lesions for all the samples. Quantitation and statistical analysis of data was performed using 

GraphPad PRISM statistical software (see Statistical Analysis). For the immunostained 

retinal images, we employed a similar method for analysis. The fluorescent image was 

opened from within the application and converted to a gray scale 8-bit image (see File S2). 

Next, the rectangle drawing tool was used to demarcate a fixed size rectangular border that 

encompassed the entire stained region of interest (GCL to RPE) for GFAP, PAD4, and F95 

staining. The subretinal region was demarcated for fibronectin staining. From the Image 
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menu the dropdown Duplicate was selected and when applied resulted in a new smaller 

window containing the selected rectangular region to appear. This image was subjected to 

thresholding by selecting from Image menu → Adjust from the dropdown and then → 
Threshold. The stained areas first appeared red against the black background and upon 

thresholding they became binary images. These binary images were analyzed as done above.

2.5 | Rigor and reproducibility

Two separate individuals performed quantification separately to achieve unbiased 

measurements. Samples were randomized by arbitrarily selecting either left or right eyes 

from within each group. To randomize the analysis, different batches of C57BL/6 mice 

procured from the vendor were subjected to experimental injury over a 2-year period. The 

uninjured mice also came from these batches and were randomly selected. Laser injury 

experiments on the male and female PAD4cKO mice and control transgenic mice were also 

performed on different cohorts of animals that were bred for over 2 years from different 

founder lines. Three trained individuals performed the laser injuries at different times in 

this study, and as such, eyes from such separate experiments were collectively used for 

analysis. Mice of both sexes were employed, and the sex of mice were recorded, although 

the analyses were performed blinded to the sex. As no significant differences were noted in 

the results after revealing of the sex, these findings represent responses of male and female 

mice to the laser injury.

2.6 | Statistical analysis

Statistical analysis was performed using GraphPad Prism 9 software (Graph Pad Software, 

San Diego, CA, USA; RRID:SCR_002798). Experiments were designed for sample size 

of N = 10 mice/group based on our prior studies that tested for significant differences in 

these same protein targets investigating injury-related retinal gliosis (Wizeman et al., 2016; 

Wizeman & Mohan, 2017). These targets have also been investigated in the optimized laser 

injury protocol to study retinal gliosis (Palko et al., 2022) that was employed here. Routine 

experiments were typically conducted using N = 4–5 mice/group and entire experiments 

were repeated over different days to attain the sample size. On infrequent occasions, if 

the laser burn caused retinal microvascular hemorrhage to occur then those mice were 

excluded from analysis. Such technical issues and loss of blots to background issues 

preventing analysis resulted in fewer samples for some analysis than what was planned 

originally. Western blot data were analyzed using the Kruskal-Wallis nonparametric test with 

Dunn’s multiple comparisons using statistical hypothesis testing as values did not show a 

normal distribution. The H statistic is reported. Groups were considered independent and 

comparisons of the 7- and 16-day injury samples to the control group was made as unpaired 

samples. A value of p < .05 was considered significant. For the data derived from analysis 

of immunostained retinas and fundus lesion which did not show a normal distribution the 

Mann–Whitney two-tailed nonparametric test was employed, and samples were considered 

independent. The U statistic is reported. For analysis of immunostained retinal data that 

showed normal distribution the two-tailed unpaired parametric t test with Welch’s correction 

without assuming equal standard deviation (SD) was employed. The t statistics is reported. 

A value of p < .05 was considered significant.
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3 | RESULTS

3.1 | Citrullination is localized to GFAP filaments in laser-induced retinal gliosis

We recently established that polymeric, citrullinated GFAP is detectable in endfeet of 

reactive Müller glia in the laser-injury mouse model of CNV. These findings revealed 

that activation of citrullination in Müller glia is lesion specific (Palko et al., 2022). Here, 

we extended this study to determine the temporal regulation of citrullination during laser 

injury-induced retinal gliosis by first examining retinal tissue at 7 days post-laser injury 

(Fabian-Jessing et al., 2022). This time point reflects the growth and remodeling of GFAP 

filaments in reactive Müller glia whose cell processes span the thickness of the retina 

extending to the fibrovascular lesion (Giani et al., 2011; Ishikawa et al., 2016) paralleling 

similar IF protein dynamics as observed in the alkali injury model (Wizeman et al., 2016). 

As anticipated, in uninjured retinas, GFAP was mainly localized to ganglion cell layer 

(GCL) astrocytes (Bargagna-Mohan et al., 2010), whereas in 7-day injured retinas, GFAP 

was localized in Müller cells from the endfeet through all layers of the retina, terminating at 

the level of the degenerated photoreceptor outer segments marking the lesion site (Figure 1).

Citrullination (F95 staining) was confined to retinal blood vessels in control retinas but 

was observed in long Müller cell processes colocalizing with GFAP staining in injured 

retinas (Figure 1). The staining of GFAP and F95 was quantified (see Methods and File 

S2) and both proteins showed a significant increase in the lesion site compared to uninjured 

retinas (Figure 1b). This pattern of staining is consistent with previous findings showing 

citrullination colocalizes with GFAP as revealed by confocal microscopy (Palko et al., 

2022), but also identifies that GFAP is modified in injured retinas in a manner similar to that 

found in alkali injury (Wizeman et al., 2016).

3.2 | PAD4 is associated with GFAP and is upregulated post-laser injury

Previously, we showed that PAD4 is upregulated during gliosis and colocalized with GFAP 

filaments in Müller glia in the alkali injury model (Wizeman & Mohan, 2017). Therefore, 

we determined whether PAD4 is similarly restricted to endfeet or distributed through 

Müller cell processes and associated with growing polymeric GFAP filaments (Figure 2). 

In uninjured control retinas, there was weak and diffuse PAD4 staining between the inner 

nuclear layer (INL) and outer nuclear layer (ONL) (Figure 2a). However, 7 days after 

injury, a striking pattern of PAD4 expression was evident on Müller glial filaments: PAD4 

expression was concurrent and colocalized with GFAP expression. The colocalization of 

PAD4 on GFAP filaments confirms our prior studies using confocal microscopy (Palko et 

al., 2022; Wizeman & Mohan, 2017). The staining of GFAP and PAD4 was quantified (see 

Methods and File S2), and both showed a significant increase in the lesion site compared 

to uninjured retinas (Figure 2b). Interestingly, PAD4 staining was most prominent in Müller 

endfeet, and was found tracking the GFAP IFs into the INL with staining also seen in Müller 

cell soma. As with citrulline/F95 staining, PAD4 staining was also observed on fewer GFAP 

filaments and prominently at the lesion site. These GFAP-PAD4 positive filaments extend 

from the endfeet through the INL and vary in length. Comparisons of F95 staining (Figure 

1b) and PAD4 staining (Figure 2b) with that of GFAP in the 7-day injured retinas revealed 

an interesting finding. Both F95 and PAD4 showed similar abundances but significantly 
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lower abundance than GFAP (GFAP mean rank = 45.50; F95 mean rank = 23.0; PAD4 mean 

rank = 22.59 with F95 vs. GFAP, p < .0001; PAD4 vs. GFAP, p = .0001; Kruskal-Wallis 

nonparametric with Dunn’s multiple comparisons test). Collectively, these results reveal that 

increased PAD4 production correlates with F95 staining in reactive Müller glia and likely 

drives hypercitrullination in the laser injury model.

3.3 | Soluble GFAP increases in laser-induced retinal gliosis

GFAP hypercitrullination is known to alter filament dynamics and cause GFAP 

depolymerization in vitro (Inagaki et al., 1989). However, whether citrullinated GFAP that 

was produced after laser injury remains as a cytoskeletal protein in vivo is unclear. To 

determine the distribution of soluble and cytoskeletal forms of GFAP after injury (see 

Methods), we performed western blot analysis of these two fractions from retinas of control 

and 7- and 16-day post-laser injured mice. The 16-day time point reflects when changes 

in reactive Müller glia occur in response to alterations in retinal thickness that correspond 

to the reduction in subretinal edema (Giani et al., 2011). Notably, levels of soluble GFAP 

were significantly upregulated at 7-day post-injury and trended to remain upregulated at 

16-day post-injury compared to control uninjured retinas (Figure 3a,c,e). Interestingly, there 

were no significant changes in the amount of cytoskeletal GFAP after injury at either time 

point (Figure 3b,d,f). These results suggest that upon laser injury, the increased cytoskeletal 

GFAP (visualized by immunostaining) in reactive Müller glia may be unstable, and hence, 

are extracted into the soluble buffer, thus producing increased amounts of soluble forms of 

the protein.

3.4 | Soluble citrullinated protein increases in laser-induced retinal gliosis

We next asked whether citrullinated species associated with reactive gliosis were also 

differentially distributed in soluble and cytoskeletal fractions by laser injury. Using western 

blot analysis, we determined that several protein species of different sizes were detected in 

the soluble fraction. In previous studies, we characterized citrullinated isoforms of GFAP 

using two-dimensional gel analysis (Wizeman et al., 2016). We utilized the same antibody to 

detect citrullinated species in the laser injury model. A soluble citrullinated protein species 

at 50 kDa, as shown previously by co-immunoprecipitation studies (Wizeman et al., 2016) 

is likely citrullinated GFAP (Figure 4a, arrowhead). The intensity of this 50 kDa band 

increased significantly at 7 days post-injury from control levels and remained significant 

at 16 days post-injury (Figure 4c). Soluble citrullinated protein species at 75 kDa (Figure 

4a, arrow) showed a similar trend showing an increase at 7 days that became significant 

at 16 days post-injury (Figure 4d). As the size of PAD4 is represented by 75 kDa species, 

this band is potentially auto-citrullinated PAD4 (Mondal et al., 2021) that is produced 

post-injury. Lastly, the high molecular weight (HMW) citrullinated proteins (sized >100 

kDa, Figure 4a,f, bracket) increased significantly at 7 and 16 days post-injury (Figure 4e,i).

3.5 | Cytoskeletal high molecular weight (HMW) citrullinated proteins increase in laser-
induced retinal gliosis

Although soluble citrullinated proteins were increased in focal lesions, we were interested 

in knowing if any citrullinated species remained stably associated with the cytoskeletal 

insoluble fraction. We found that HMW citrullinated species in the insoluble cytoskeletal 
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fraction were significantly increased at 16 days post-injury, as determined by western blot 

analysis (Figure 4f,i). This could indicate that a pathological state has developed over 16 

days, as a similar accumulation of HMW citrullinated proteins was also previously reported 

in the severe alkali injury model that results in retinal degeneration (Wizeman et al., 2016). 

Interestingly, HMW citrullinated protein species after laser injury also trended higher in 

the cytoskeletal fraction at the earlier time point of 7 days but revealed greater complexity 

(more bands) and became significant at 16 days post-injury (Figure 4f,i), a time point when 

the 75 kDa citrullinated band showed a dramatic reduction (Figure 4h). The citrullinated 

50 kDa GFAP band was barely detected in cytoskeletal extracts from the injured retinas 

revealing that this protein was readily soluble. These findings further establish that changes 

in the repertoire of citrullinated targets and their differential distribution between soluble and 

cytoskeletal fractions occurred at the 16-day post-injury time point.

3.6 | Cytoskeletal PAD4 increases in laser-induced retinal gliosis

Because citrullinated proteins were increased after laser injury, we anticipated that levels of 

PAD4, the relevant PAD isozyme (Wizeman & Mohan, 2017), would also have increased. 

We confirmed this by western blot analysis. Soluble PAD4 protein levels showed a trend of 

increased expression at 7- and 16-day post-injury compared to controls (Figure 5a,c), with 

significantly increased expression being seen instead in the insoluble cytoskeletal fraction 

at 16 days post-laser injury (Figure 5b,d). These findings indicate that PAD4 had indeed 

increased expression contributing to the increased levels of citrullinated proteins. However, 

increased PAD4 levels preferentially distributed in the cytoskeletal fraction at 16 days 

post-injury suggested that cytoskeletal-associated PAD4 may represent the fraction of PAD4 

that remains non-citrullinated. These data also correlate with PAD4 colocalizing on GFAP 

filaments as shown here (Figure 2) and previously by immunostaining analysis (Wizeman & 

Mohan, 2017).

3.7 | Pharmacogenetic ablation of PAD4 reduces hypercitrullination and subretinal 
fibrosis

Since PAD4 plays a central role in retinal gliosis by governing the stress-induced 

citrullination of GFAP (Palko et al., 2022; Wizeman & Mohan, 2017), we selectively 

ablated Padi4 gene expression in glial cells by crossing GFAP-CreERT2 with Padi4flox/

flox mice and administering tamoxifen to induce PAD4 deficiency (PAD4cKO mice). Our 

earlier study revealed that citrullinated GFAP levels, abundantly expressed after injury were 

reduced in PAD4 deficiency (Palko et al., 2022). Moreover, western blot analysis also 

confirmed significant reductions of several hypercitrullinated species that correlated with 

reductions in PAD4 protein levels in injured PAD4cKO retinas (Palko et al., 2022). These 

findings, therefore, prompted us to examine the consequences of PAD4cKO on laser-injury 

chronic gliosis and hypercitrullination with relevance to subretinal fibrosis at the 30-day 

time point post-injury (Ishikawa et al., 2016). Immunostaining analysis of mouse retinas 

30 days post-laser injury revealed that filamentous GFAP was abundant in Müller glial 

processes and visualized extending to the outer nuclear layer of lesion sites of injured 

control retinas (Figure 6). These long GFAP+ filaments showed a high level of overlap with 

citrullination (F95) staining (mean GFAP = 121.9 ± 45.19; mean F95 = 122.2 ± 44.96; 

Mann–Whitney test, U = 0, n1 = 17, n2 = 17, p = .9458). This finding suggested that by 
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30 days post-injury GFAP stained filaments in lesioned areas were completely marked by 

citrullination (hypercitrullinated). In comparison, GFAP staining in the injured PAD4cKO 

retinas was more restricted, with staining for GFAP in Müller cell processes reaching only 

the inner nuclear layer and being relatively sparse. Notably, citrullinated species were largely 

undetected in PAD4cKO retinas by immunostaining (Figure 6). The staining of F95 was 

quantified and showed very significant decrease in citrullinated species in the PAD4cKO 

mice compared to the control (Figure 6e). This reduction of citrullination staining correlated 

with that previously observed by western blot analysis (Palko et al., 2022). Thus, loss 

of filamentous citrullinated species in PAD4cKO retinas indicates that PAD4 enzymatic 

activity may be integral to the maintenance of hypercitrullination at this chronic stage of 

injury. GFAP staining quantification also showed significant reduction in PAD4cKO mice 

compared to controls, although not to the same extent as that of F95 (Figure 6e). Therefore, 

next we wanted to determine whether conditional glial-specific targeting of PAD4 reversed 

structural changes in the injured retina that would be reflected by alterations to GFAP 

filaments within Müller glia (Bringmann et al., 2009). To examine this, we quantified lesion 

size using live fundus imaging of laser-injured mice 30 days post-injury. We found that 

lesion sizes differed significantly between control (mean = 3.003 ± 0.4988) and PAD4cKO 

(mean = 2.058 ± 0.5147) injured mice (Mann–Whitney U test, p < .0001, Figure 7b), 

suggesting that there may be improvement in tissue repair in PAD4 deficiency. These data 

prompted us to examine whether lesion-associated subretinal fibrosis (Ishikawa et al., 2016), 

as reflected by the amount of fibronectin deposition (Linder et al., 2021), was also affected 

by PAD4 conditional knockout. PAD4cKO and control retinas 30 days post-injury were 

immunostained for fibronectin, and we measured areas of subretinal staining at lesion sites 

(Figure 8, see File S2). We found that the PAD4cKO injured retinas had a very significant 

reduction in fibronectin staining (mean = 0.3764 ± 0.1005) compared to the high amount 

of fibronectin in the control injured retinas (mean = 2.219 ± 0.4313) (Welch’s parametric t 
test, p < .0001; Figure 8e,f). Taken together, these findings reveal that PAD4 overexpression 

in reactive Müller glia plays an important role in the development of subretinal fibrosis. 

This indicates that chronically reactive Müller glia may be responsible for perpetuating the 

fibrotic outcome via engaging the PAD4-citrullination axis.

4 | DISCUSSION

Fibrotic scarring is associated with chronic retinal gliosis and remains an inevitable outcome 

in ~45% of patients with advanced wet-AMD (Daniel et al., 2014). We recently reported that 

retinal gliosis elicited in the mouse laser injury model of accelerated CNV is associated with 

PAD4-driven hypercitrullination. We illuminated that injury-induced PAD4 upregulation 

governed the production of citrullinated GFAP, and this citrullination originates from Müller 

endfeet (Palko et al., 2022). Here we show, for the first time, that in conditional PAD4-

deficient retinas, laser-induced Müller glial hypercitrullination was reduced dramatically on 

a global level, resulting in altered GFAP production and attenuated subretinal fibrosis.

One of the earliest hallmarks of retinal gliosis is the de novo production of GFAP in Müller 

glia (Lewis & Fisher, 2003), entailing Gfap mRNA synthesis and its transport to the endfeet 

for translation (Sarthy et al., 1989). Soluble GFAP produced in the endfeet is polymerized 

rapidly as the filamentous forms of GFAP are observed very early after injury (Wizeman 
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et al., 2016). We have shown these polymeric GFAP filaments are also citrullinated at the 

endfeet and previously posited that the cellular components to drive translation (Sarthy 

et al., 1989) and citrullination may be present in the endfeet (Palko et al., 2022). As 

immunostaining showed the colocalization of PAD4 at the endfeet, we believe that the 

PAD4-citrullination axis is intimately linked to Müller cell gliosis. This finding was novel 

because PAD4 has never been colocalized with any of its intermediate filament substrates 

in such a compartmentalized manner. This also exemplifies that this unique mechanism may 

be a construct of biology to serve the polarized structure of the neurosensory retina. Thus, 

we speculate that initiating stress-induced citrullination at Müller cell endfeet, an anatomical 

site located distally from photoreceptors, could be a protective strategy to promote repair 

after a minor injury. This way, acute gliosis could occur concurrently without disruption 

of phototransduction in the photoreceptor outer segments. However, in events of severe 

traumatic injury or genetic diseases producing a permanent protein deficit/abnormality, the 

ensuing chronic retinal gliosis would provide a conduit for Müller cell-mediated transport of 

PAD4 through cell processes via the cytoskeleton. Under such a pathological scenario, the 

repertoire of citrullinated species would increase both in abundance and complexity. Thus, 

the chronically activated Müller would continue to produce these citrullinated proteins at 

the endfeet that would impact outer retinal layers to cause degeneration. In support of this 

idea, JR5558 mice that spontaneously develop retinal degeneration from lesions that arise 

in defective photoreceptor outer segments (Chang et al., 2018) were found to have robust 

gliosis with highly citrullinated filaments that extended all the way to the apical end of 

Müller glia by 1 month of age (Palko et al., 2022). Also, in laser-injured mouse retinas, 

citrullinated filaments extended to the apical end of Müller glia (Palko et al., 2022), which 

correlated with temporal changes in the abundance and pattern of citrullinated proteins 

produced over the 16-day-injury period. Thus, the spread of citrullination from the endfeet 

to the outer retina and its temporal retention appears to manifest when acute gliosis fails 

to resolve. As such, the endfeet should be recognized as a critical subcellular domain 

compartmentalized to drive retinal citrullination in both the acute and chronic stages of 

pathology. This idea is consistent with our recent findings that showed citrullinated GFAP 

in the endfeet of human wet-AMD maculae with chronic gliosis at this advanced stage of 

fibrosis (Palko et al., 2022). Accordingly, we have named the endfeet of reactive Müller glia 

the “citrullination bunker” (Palko et al., 2022).

To better understand the structural regulation of GFAP via its citrullination, we analyzed 

retinal extracts at 7- and 16-day post-injury using western blots. Our findings reveal 

that the temporal increase in GFAP and citrullinated species occurs both in the soluble 

and cytoskeletal fractions, suggesting that immunostained filamentous citrullinated GFAP 

contains a certain number of unstable subunits that were readily solubilized. While these 

data are illuminating, limitations of our study are that some data (western blots) that have 

lent support to our results were derived from small sample sizes. Also, the nature of the 

interactions of PAD4 with GFAP is ambiguous. However, these observations still provide a 

basis for hypothesis testing should such a PAD4-GFAP binding interaction be found to be 

true. Then, the dramatic loss in the 75 kDa citrullinated PAD4 species in the cytoskeletal 

fraction at the 16-day time point suggests auto-citrullinated PAD4 (Wizeman & Mohan, 

2017) is being released from polymeric GFAP at later stages in injury. In apposition 
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to this idea, increased abundance of PAD4 in the cytoskeletal fraction indicates that an 

inverse relationship may exist; PAD4 decreases its binding to polymeric GFAP when PAD4 

becomes increasingly auto-citrullinated. Thus, PAD4 auto-citrullination may not only cause 

autoinhibition of PAD4 enzymatic activity (Mondal et al., 2021), but auto-citrullination of 

PAD4 may also be a breaking mechanism to limit the amount of activated PAD4 being 

chaperoned in the direction of the outer nuclear layer on the IF cytoskeleton. Future studies 

will be needed to define how potential interactions of PAD4 with GFAP are altered as 

a reflection of citrullination during the polymerization and dynamic remodeling of GFAP 

filamentous structures. Alternatively, one might anticipate that dynamic changes also in 

cell size and shape of reactive Müller glia would correspondingly require GFAP polymers 

to adapt to alterations in cell stiffness and retinal thickness (Middeldorp & Hol, 2011) 

that continue to occur even at later time points post-laser injury (Giani et al., 2011). 

Future studies could help illuminate whether hypercitrullination of GFAP drives these 

cellular alterations or are the result of such structural alterations to the retina. Finally, other 

substrates of PAD4 that potentially govern Müller glial cell biological processes need to be 

identified and characterized, which is an important study that remains to be done.

Conditional abrogation of PAD4 in Müller glia reduces GFAP polymeric expression, as 

much shorter and sparser GFAP filaments were detected 30-day post-injury in PAD4cKO 

mice compared to injured controls. The dramatic reduction in retinal lesion size in 

PAD4cKO mice hints that hypercitrullination may be driving structural changes in the 

injured retinas. One thought is that the lesioned areas of the retina may undergo tissue 

remodeling more effectively because of attenuated citrullination. Global reduction of 

citrullinated protein species was also significant at 16 days post-injury in laser injured 

PAD4cKO retinas compared to injured controls (Palko et al., 2022), suggesting that 

downregulation of hypercitrullination and maintenance of low level of gliosis could be 

beneficial for repair over pathological engagement of fibrosis. In keeping with this, 

the consequence of attenuation of the PAD4-citrullination axis results in significantly 

diminished subretinal fibrosis (lower fibronectin levels), which corroborates a role for PAD4 

in retinal fibrosis. As such, PAD4 deficiency or its inhibition in several other animal models 

of fibrotic conditions have resulted in protection (Kawalkowska et al., 2016; Knight et al., 

2015; Lange et al., 2014; Suzuki et al., 2020; Vassiliadis et al., 2013), identifying this PAD 

enzyme as a major player in fibrosis. Moreover, the consequence of PAD4 overexpression 

could also eventually lead to development of immune deviation through generation of 

autoantibodies to PAD4 (Acharya et al., 2012), as well as to GFAP (Darrah & Andrade, 

2018), or to other PAD4 substrates, which ultimately could be factors that exacerbate 

the disease process. Nevertheless, while our study focuses solely on reactive Müller glia, 

astrocytes may also contribute to gliosis in this injury model in other ways, but it is unlikely 

that astrocytes located at the GCL influence subretinal fibrosis.

Together, our findings on the PAD4-citrullination axis in Müller cell gliosis suggest a 

potential role for PAD4 in AMD through effects on the fibrotic process (Palko et al., 2022). 

Whether this mechanism also interferes with CNV now remains to be tested. As PAD4 is 

also a therapeutic target in other chronic diseases (Jones et al., 2009), future studies should 

investigate the impact of pharmacological inhibition of PAD4 on disease progression in the 

retina.
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Significance

This research study is significant because it contains novel information about a potential 

mechanism that links retinal Müller glial hypercitrullination to subretinal fibrosis. We 

show that functional reduction of PAD4 that abrogates hypercitrullination improves 

retinal injury and diminishes subretinal fibrosis, potentially through its effects on GFAP 

dynamics. These new data are important for consideration of scarring in retinal diseases 

like age-related macular degeneration as its also illuminates PAD4 as a potential drug-

gable target for fibrotic conditions.
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FIGURE 1. 
Citrullination colocalizes with GFAP filaments in laser-injured mouse retinas. (a) 

Representative epifluorescent images of control uninjured and 7-day post-laser injury retinal 

samples stained for GFAP (green) and peptidyl-citrulline/F95 (red). Nuclei were visualized 

with DAPI (blue). Citrullinated proteins were present on filaments and colocalized with 

GFAP. Merge is an overlay of all staining. All images were taken at 20× magnification. 

GCL, ganglion cell layer; INL, inner nuclear layer; ONL, outer nuclear layer. The asterisks 

(a) denote the site of the laser lesion. (b) Quantification of GFAP and F95 staining was 

done using ImageJ software and data analyzed using graph pad Prism software. The Mann–

Whitney two-tailed nonparametric test was used for statistical analysis. Median GFAP 

abundance of uninjured and 7-day injured samples were 16.36 and 129.8, respectively; the 

two groups differed significantly (U = 0, n1 = n2 = 22, *p < .0001). Median F95 abundance 

of uninjured and 7-day injured samples were 14.91 and 98.48, respectively; the two groups 

differed significantly (U = 0, n1 = n2 = 22, **p < .0001). N = 6 mice/group, average of 

three sections per mouse. Data are presented as mean ± SD, p < .05 is considered significant. 

Scale bar = 105 μm.
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FIGURE 2. 
PAD4 is upregulated and localized with GFAP in the injured mouse retina. (a) 

Representative epifluorescent images of control uninjured and 7-day post-injury retinal 

samples stained for GFAP (red), PAD4 (green). Nuclei were visualized with DAPI (blue). 

PAD4 staining was observed colocalized with GFAP filaments originating from the endfeet 

(white empty arrowheads) and extending to the inner retina of injured tissues. Merge is 

an overlay of all staining. All images were taken at 20× magnification. GCL, ganglion 

cell layer; INL, inner nuclear layer; ONL, outer nuclear layer. The asterisks (a) denote the 

site of the laser lesion. (b) Quantification of GFAP and PAD4 staining was done using 

ImageJ software and data analyzed using graph PAD Prism software. The Mann–Whitney 

two-tailed nonparametric test was used for statistical analysis. Median GFAP abundance 

of uninjured and 7-day injured samples was 26.68 and 174.0, respectively; the two groups 

differed significantly (U = 0, n1 = 18, n2 = 20, *p < .0001). Median PAD4 abundance 

of uninjured and 7-day injured samples was 6.15 and 94.40, respectively; the two groups 

differed significantly (U = 0, n1 = 18, n2 = 20, **p < .0001). N = 6 mice/group, average of 

three sections per mouse. Data are presented as mean ± SD, p < .05 is considered significant. 

Scale bar = 105 μm.
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FIGURE 3. 
Soluble GFAP increases in mouse retinas after laser injury. Soluble (a) and insoluble (b) 

cytoskeletal fraction were isolated from control uninjured and injured retinas (7- and 16-day 

post-injury) and subjected to western blot analysis. Blots were probed with GFAP antibody. 

(c,d) Stain-free gels were used as protein loading controls. Quantitation of GFAP bands 

normalized to stain-free gels was done using ImageJ software and data analyzed using 

GraphPad Prism software. (e) The Kruskal–Wallis test with Dunn’s multiple comparisons 

revealed a statistically significant difference of soluble GFAP abundance between uninjured 

and 7-day injured samples, H (2, N = 12) = 8.0; *p = .0121, but the 16-day injured 
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sample did not show significant differences (p = .0997) (N = 10 mice/group). (f) The 

Kruskal–Wallis test with Dunn’s multiple comparisons did not reveal statistically significant 

differences for cytoskeletal GFAP abundance between uninjured and 7-day or 16-day injured 

samples, H (2, N = 15) = 2.94; p = .256. Data are presented as mean ± SD, p < .05 is 

considered significant.
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FIGURE 4. 
Soluble citrullinated proteins increase in mouse retinas after laser injury. Soluble and 

insoluble cytoskeletal fractions were isolated from control uninjured and injured retinas 

(7- and 16-day post-injury) and subjected to western blot analysis. Blots were probed 

with citrullination/F95 antibody. (a) Multiple soluble bands were visualized at 50 kDa 

(arrowhead), 75 kDa (arrow), and >100 kDa (HMW, bracket). Quantitation of soluble F95 

bands normalized to stain-free gels (b) was done using ImageJ software and data analyzed 

using GraphPad Prism software. Kruskal–Wallis test with Dunn’s multiple comparisons was 

performed for data from individual bands. Compared to the uninjured sample the soluble 

50 kDa band (c) was significantly increased at 7 days post-injury H (2, N = 15) = 8.06; 

*p = .0473, and at 16 days post-injury; *p = .0178. The abundance of the 75 kDa band 

(d) increased significantly at 16 days post-injury, H (2, N = 15) = 6.860; *p = .0267, but 

not at 7 days post-injury (p = .0954). (e) Soluble high molecular weight (HMW) species 

were also significantly increased at 7 days, H (2, N = 15) = 9.980; *p = .0473) and at 

16 days post-injury (**p = .0047). (f) Multiple bands from the cytoskeletal extracts were 

visualized; 75 kDa (arrow) and several above 100 kDa (HMW, bracket). (g) Stain-free gels 

were used as protein loading controls for normalization of bands. (h) Compared to the 

uninjured sample the 75 kDa band from the insoluble fraction at 7- and 16-day post-injury 

did not show significant differences, H (2, N = 9) = 1.422; p = .5429 (N = 6 mice/group). (i) 

Quantitation of the HMW bands from the insoluble fraction revealed significant increase at 

16-day post-injury, H (2, N = 9) = 5.956; *p = .0341 but not at 7-day post-injury (p = .2021). 

N = 6 mice/group. Data are presented as mean ± SD, p < .05 is considered significant.
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FIGURE 5. 
PAD4 increases in the insoluble cytoskeletal fraction in laser injured retinas. Soluble (a) 

and cytoskeletal (d) fractions were isolated from control uninjured and injured retinas 

(7- and 16-day post-injury) and analyzed by western blot analysis. Blots were probed 

with PAD4 antibody. Quantitation of the soluble PAD4 band normalized to stain-free gels 

(b) was done using ImageJ software and data analyzed using GraphPad Prism software. 

Kruskal–Wallis test with Dunn’s multiple comparisons of PAD4 abundance from uninjured 

sample compared to 7- and 16-day injured samples (c) revealed there were no significant 

changes at either time point, H (2, N = 9) = 4.460; p = .1055. The insoluble cytoskeletal-

associated PAD4 levels (d) showed increased abundance. (e) Stain-free gels were used as 

protein loading controls for each fraction, respectively. (f) Quantitation of the cytoskeletal 

associated 75 kDa band revealed significant increased abundance at the 16-day post-injury 

time point, H (2, N = 9) = 5.956; *p = .0341, but not at the 7-day injury time point (p = 

.2021). Data are presented as mean ± SD, p < .05 is considered significant.
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FIGURE 6. 
Conditional knockout of PAD4 attenuates citrullination in mice subjected to retinal laser 

injury. Representative images from control (a) and PAD4cKO (c) retinas at 30 days post-

laser injury. Cryosections were immunostained for GFAP (green) and citrullination with F95 

(red). (a) F95 staining was evident on GFAP filaments in the lesions of control mice, while 

no F95 staining was observed in the lesions of PAD4cKO mouse retinas (c). Filamentous 

GFAP staining in PAD4cKO mouse retinas was reduced and sparse. (b,d) Enlarged images 

of the overlapping staining (Merge) boxed regions. The asterisks (a,c) denote the site of the 

laser lesion. GCL, ganglion cell layer; INL, inner nuclear layer, ONL, outer nuclear layer. 

Scale bar: a = 105 μm; scale bar: b = 35 μm. Quantification of GFAP (e) and F95 (f) staining 

using ImageJ software was performed (see File S3) and data analyzed using Mann–Whitney 

two-tailed nonparametric U test. Median GFAP staining of control samples and PAD4cKO 

samples were 120.0 and 29.75, respectively; the two groups were significantly different (U 
= 8, n1 = 17, n2 = 16, **p < .0001). Median F95 staining of control samples and PAD4cKO 
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samples was 131.5 and 9.821, respectively; the two groups were also significantly different 

(U = 0, n1 = 17, n2 = 16, **p < .0001). N = 6 mice/group, average of three sections per 

mouse. Data are presented as mean ± SD, p < .05 is considered significant.
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FIGURE 7. 
Conditional knockout of PAD4 reduces lesion size of laser-damaged retinas. Retinal fundus 

images from control and PAD4cKO retinas from 30-day post-injured mice were acquired on 

a Phoenix Micron III fundus microscope. (a) Control mice revealed larger lesions compared 

to those from PAD4cKO mice. The boxed images represent measurements of individual 

lesions used for quantification. (b) Lesion sizes were quantified using ImageJ software and 

statistical analysis done using Mann–Whitney two-tailed nonparametric test. Median lesion 

size of control samples and PAD4cKO samples was 2.948 and 2.130, respectively; the two 

groups were significantly different (U = 304.5, n1 = 52, n2 = 76, **p < .0001). N = 7 

control mice (52 lesions) and N = 10 PAD4cKO mice (76 lesions) were analyzed. Data are 

presented as mean ± SD, p < .05 is considered significant.
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FIGURE 8. 
Conditional knockout of PAD4 reduces fibronectin deposition in laser-injured retinas. 

Representative images of control and PAD4cKO retinas at 30-day post-injury from laser 

injured mice. (a) Images of control injured and PAD4cKO mice showing staining for 

fibronectin. Fibronectin deposition in the PAD4cKO lesion site was drastically reduced 

compared to the control. The asterisks (a) mark the position of laser lesion. (b) The 

area of staining representing fibronectin was quantified using ImageJ software (see also 

File S2). Statistical analysis using Welch’s two-tailed parametric t test revealed significant 

differences between control (mean = 2.219 ± 0.4313) and PAD4cKO (mean = 0.3764 ± 

0.1005) samples; t27.36 = 20.63, *p < .0001. N = 6 control mice (25 sections) and N = 6 

PAD4cKO mice (19 sections) were analyzed. Data are presented as mean ± SD, p < .05 

is considered significant. GCL, ganglion cell layer; INL, inner nuclear layer; ONL, outer 

nuclear layer.
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SCHEME 1. 
Breeding strategy for PAD4 conditional knockout. The first crossing (I) consisted of a 

male GFAP-CreERT2/+ mouse and a female Padi4flox/flox mouse. The offspring from 

this mating, a heterozygous CreERT2/+ Padi4flox/+ line was selected and subsequently 

backcrossed with the homozygous +/+ Padi4flox/flox mouse line (II) to obtain the desired 

GFAP-CreERT2/+ Padi4flox/flox mouse line termed “PAD4cKO.” The +/+ Padi4flox/flox 

mice were used as “controls” and employed in experiments. Both groups were administered 

tamoxifen for all laser injury experiments.
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SCHEME 2. 
Overview of experimental laser injury studies. (a) Wild-type C57Bl6 mice were subjected 

to laser injury and analyzed at 7- and 16-day post-injury for retinal gliosis. (b) Control 

and PAD4cKO mice were subjected to laser injury and analyzed at 30-day post-injury for 

subretinal fibrosis.
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